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Submission Name: SE_Form_012020

8

EIENE

89 9

Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:
Screen View ‘ Overview: Overview |
Notice: eSubmitter submission templates are updated monthly. Using updated templates for your submission helps ensure the latest fields and structure of each submission can be received and processed by the FDA. When you create a new submission, eSubmitter will provide the newer template. If you want to create a submission
from a prior submission, you can use the 'Save As’ option and eSubmitter will load the newer template
However, if eSubmitter updates are blocked by your IT infrasiructure then eSubmitter cannot load the newer template. If eSubmitter updates are being blocked, check the FDA eSubmitter application history on the eSubmitter webpage to locate important CTP template updates se that you can perform manual reinstalls as needed.
hitp:/www fda. gow/Forindustry/FDAe Submitter
CTP Submission

Use the arrows to navigate the submission screens.

Blue dots indicate required fields.

Please note, there are several icons within the application to help guide you. Most importantly, the light bulbs indicate additional instructions, definitions from the guidance document, and other helpful hints.
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:

Screen View ‘ Applicant Identification: Role Identification |

QOverview > Role Identification > Manufacturer Identification > Submission Type > Submission Attachments

You are in the Role Identification section. This section requesis the submitter to identify whether they are a manufacturer or importer.

‘ Help assistance ( i @fda.hhs.gov) is available to help you create your eSubmitter submissions fer the Center for Tobacce Preducts. ‘

- -
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Submission Name: SE_Form_012020 Last Modified: ‘
Report Type: CTP: Transmittal Form Date Packaged:
Screen View ‘ Applicant Identification: Manufacturer Identification )|

Qverview > Role Identification > Manufacturer Identification > Submission Type > Submission Attachments > Confirmation

You are in the Manufacturer Identification section. This section requests contact and address information for the company responsible for the submission.

- -
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

To use the eSubmitter's Address book, use the appropriate copy icens to the right

‘Organization Information

Organization Name:

QOrganization Headquarters D&B D-U-N-5& Number.

Organization Headquarters FDA Assigned Facility Establishment Identification (FEI) Number:

Organization URL (e.g., www.fda.gov)

‘Organization Mailing Address:

Country:

Address -Line 1:

Address - Line 2:

city

State

State, Province, or Territory Name

Zip or Postal Code:

Prefix

First Name/Given Name:

Middle Name:

Last Name:

Generational Suffix

*> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.)

Position Title

Email Address

Telephone Number(s):




l @ J‘ ) J‘ = J‘ @ J‘TJ 0 of 4items In the list (1 required)

Telephone Number(s)
Fax Number:
I Y J\ [ J\ =]/ ] 3 0 of 1 ftems in the list
Fax Number(s)
Mailing Address for the i 4 i ized to repi the
Is the Authorized Representatives' Organization Information the same as above? @ | Oives
2 No

Organization Mame: [ |
Country ‘ - |
Address - Line 1 [ |
Address - Line 2: ‘ ‘
City [ |
State: [ ~]
State, Province, or Territory Name L] \ |
Zip or Postal Code: [ |

-
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

Sy

To use the eSubmitter Address Book, use the appropriate copy icons to the right

slodaDs/c o de+3aee

‘Organization Information

‘Organization Name: ]

D&B D-U-N-5@ Number:

FDA Establishment Identifier (FEI).

Organization URL{e.q., www.fda.gov)

‘Organization Mailing Address:

Country:

Address -Line 1:

Address - Line 2:

State

[

[
city e | J
‘State, Province, or Territory Name: |

Zip or Postal Code: [

_ e - _
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Submission Name: SE_Form_012020

Report Type: CTP: Transmittal Form
Screen View
Is there an alternate point of contact who is legally authorized to speak on behalf of the manufacturer? [ ] O Yes

) No

Whatis the role ofthe Alternate Point of Contact? || v‘
To use the eSubmitters Address book, use the appropriate copy icons to the right “ = J| @ J
Alternate Point of Contact point of contact for
Prefix. - ‘
First NameiGiven Name: |
Middle Name: |
Last Name: |

> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.):

Position Title:

|
[
[
[
Generational Suffix | v‘
[
[
[
[

Email Address:

Telephone Number(s).

EYEYEY YR 0 of 4items in the list

Telaphone

Fax Number.

|ij‘i4ﬂij ‘ij‘ 4 J 0 of 1items in the list

Fax Number(s)

— — o e T e—

I Display Next Screen
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Submission Name: SE_Form_012020 Last Modified: 1
Report Type: CTP: Transmittal Form Date Packaged:
Screen View ‘ Submission Type: Instructions )|

Qverview > Role Identification > Manufacturer |dentification > Submission Type > Submission Attachments

You are in the Submission Type section. This section requesis the submitter to identify their submission type.

- -
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

Qverview > Role Identification > Manufacturer Identification > Submission Type > Submission Attachments

You are in the Submission Attachments section

Cover Letter

Ifyou have a cover letter, please aftach it here

File Atachment || op | o= Q, i) “

Index File

and attach the completed spreadsheet below.

Please download the eTTD index template, fill out with i ion on all the d in your
Please click on the spreadsheet link to launch the pre-formateted spreadsheet.

Index file attachment

File Attachment | = | Q ) “

Main Contents

Provide a descriptor of the main contents for your submission

FieAtachment ([ G | = | @& | 9 “

Administrative Files

Administrative Files (Check all that apply)

"] Table of Content
[ Submission Summary
|_| Statements of Certification

Provide your administrative files:

(2] s =Jaj 2]

0 items in the list

Title Name Date. Size




Submission Attachments

Please attach any additional documents relevant to this submission (e.g., chart, graph, etc.). ]

EXEY S EYEFEY 0 items in the list
Tille | Name | Date Path

4]

Submission Comments

Please enter any submission comments below.

‘Outline View

|

-
Bl
Iz g
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Submission Name: SE_Form_012020 Last Modified:

Report Type: CTP: Transmittal Form Date Packaged:

aubstantiall f Submission: O

Screen View

<

Tobacco Substantial Equivalence Report Submission
Family Smoking Prevention and Tobacco Control Act

On June 22, 2009, the President signed the Family Smoking Prevention and Tobacco Control Act (Tobacco Control Act) (Public Law 111-31) info law. The Tobacco Control Act amended the Federal Food, Drug, and Cosmetic Act (FD&C Act).

Statutory Requirements

Section 910(a)(1) of the FD&C Act defines a new tobacco product as "(A)any tobacco product (including those products in test markets) that was not commercially marketed in the United States as of February 15, 2007, or (B) any modification (including a change in design, any component, any
part, or any constituent, including a smoke constituent, or in the content, delivery or form of nicotine, or any other additive or ingredient) of a tobacco product where the modified product was commercially marketed in the United States after February 15, 2007."

Section 910(a)(2) of the FD&C Act states that premarket review is required for new fobacco products. There are three pathways to receive marketing authorization. Substantial equivalence is one of the three pathways.

or (i) has different characieristics and the information submitted contains information, including clinical data if deemed necessary by the Secretary, that demonstrates thal it is not appropriate to regulate the product under this section because the product does not raise different questions of public
heaitn.”

Section 905()(1)(A)(i) of the FD&C Act includes the timeframe and basis for submission of a substantial equivalence Report (SE Report).

Complete the following question and answer form for the Substantial Equivalence Report and submit the required data to FDA's Center for Tobacco Products via the CTP Portal or FDA Electronic Submissions Gateway (ESG). To register with the FDA ESG, go to www.fda.gow/esq/.

For your reference, see the Qverview of Substantial Equivalence (SE) .

Please note, there are several icons within the application to help guide you. Most importantly, the light bulbs indicate additional instructions, definitions from the guidance document, and other helpful hints.

An agency may not conduct or sponsor. and a person is not required to respond to, a collection of information uniess it displays a currently valid OMB control number. The OMB control number for this information collection is 0910-0650 (expires 6/30/2019).

Blue dots indicate required fields.

Section 910(a)(3) of the FD&C Act states that "substantial equivalence” means, with respect to the tobacco product being compared fo the predicate tobacco product, that the Secretary by order has found that the tobacco product "(i) has the same characieristics as the predicate tobacco product;

- -
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:
Screen View | Substantially i issi SE Report Type ,.?Jl

Substantial Equivalence Report Type

> Full Substantial Equivalence Report

Select Report Type:

[ Streamlined Substantial Equivalence Report

@ to

Report

STN being Amended:

@R

Outline View
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged: ‘

Screen View y

Overview > Submission Information > Tobacco Product Information > Predicate Manufacturer Information > Manufacturing/Packaging Sites Information > Submission
Information and Contents

You are in the Submissien Information section. This section requests ir 1 related to the , along with any cross references and formal meetings.

- -
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

Q

FEREEDE)

Screen View

Type of Application @ | ) same Characteristics Report
) Different Characeristics Report
‘Submission Summary (As described in 21 CFR 1107. 18(d), please summarize the submission below): "]
Proposed modificitation(s) to the New Tabacco Product (as compared to the predicate tobacco product) (Check all that apply): @ | [ Tobacco Blend
[ Design
[7] material
[T Container Closure System
[_] Heating Source
[Z] Product Quantity
[l Ingredients
[ other
* | Ingredients (specify).
4
> | Other (specify):
g

- -
|
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Submission Name: SE_Form_012020
Report Type:

CTP: Transmittal Form

PEEEEEIDE

Screen View

Last Modified:
Date Packaged:
= ——
9
[ ) | ~ il @ 1 List | Detail A Info J | @ J & J
Add New ltem
[ smi = |
Letter of Authorization attachment:
File Attachment H & J =] || |
Information and Sections to be referenced from Master File.
g
T — s R |
—
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Submission Name: SE_Form_012020

Report Type: CTP: Transmittal Form
H o " - J[ T J l List J‘ Detail J[ Info J ‘ @ J W J

New Tobacco Product Name of the Cross-referenced STN

Cross-referenced Submission Type ‘ v‘
Other [ |
Cross-referenced Submission STN |

Dacument Filename
Document or Study Title
Date Submitted | i

Table of Contents Category

Document Key Word(s)

l % Jl % J‘ElE‘E 0 0of 10 items in the list

K% OPTIONAL- Enter words that describe the content of the document”
=
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

BB EI I

Screen View

L & | = I = J | is J I = || & | D i
List the FDA submission tracking numbers {STNs) for all your previous requests for the new tobacco products (e.g., TP, SE, MRTPA) where applicable
New Tobacco Product Name of Related Submission
|
Related Submission Type ‘ -
Other [ |
Related Submission STN |

|
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Report Type:

Help

CTP: Transmittal Form

Screen View

| @ J

- ] = 1l = J‘

Formal Meetings Held with FDA pertaining to this tobacco product (For each meeting, as needed, enter the STN number and meeting held date.)

| Info ] |

Mew Tobacco Product Name (Provide product name if meeting is relevant to a specific product)

Meeting STN (e.g.. TC1234567)

Meeting Held Date

@ s s
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Simple
Submission Name: SET h 012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:

i i issi Tob Product Information

Screen View ‘

Overview > Submission Information > Tobacco Product Information > Predicate Manufacturer Information > Manufacturing/Packaging Sites Information > Submission
Information and Contents

You are in the Tobacco Preduct Information section. This section requests tobacco product information, including product category and product sub-category.

Check this box if your product is co-packaged, meaning multiple components are contained in the same container closure system (e.g., a tin that contains both loose tobacco filler and rolling papers together)

Click this link to download the Product Spreadsheet to your local machine.

Please select 'SE' as your application type, then fill in your information on the spreadsheet and attach it below.

Tobacco Product Information

'/': Please fill in information for only one productin this spreadsheet. If you would like to submit information for multiple products, please use the "save-as’ feature to create a submission for each product, and fill in the spreadsheet for information pertaining to that product.

Please save your attach your spreadsheet as an xlsx document, not an xlsm

Attach your Tobacco Product Information spreadsheet

File Attachment “ Y IEYES i “
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ined to be a (GF) product.
(2 The predicate tobacco product was previ found to be i i

() The predicate tobacco product was not previously submitted for GF review and was not found to be i

but we believe it to be product.
Name of Product

GFISE STN

Date of FDA’s GFISE Determination

e e = s

X
7 3 53 = x ] 2
EABNE TR ET=E Y

Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:

Screen View [ tantially Equi ission: Predicate Tob Product Basis l
Selectthe statement below that applies to the predicate tabacco product, and then complete all necessary information for that statament

(} The predicate tobacco product identified above was. for GF review it of this SE Report and
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

Screen View

‘ Complete the section below and attach ion, which must the predicate tobacco product identified above was commercially marketed other than for test marketing in the United States as of February 15, 2007 ‘

Type of Evidence ‘ v‘

Other. ‘ |

Dale of Evidence ® | J

Evidence of dentifier (.q., Invoice Number)

Commercial Information (e.g., UPC Code, SKU Number) ] | \

Commercially Marketed Business Address

Country, L] ‘ v‘

Address - Line 1 @ | ]

Address - Line 2: [ ]

city @ | |

State: ‘ - ‘

State, Province, or Territory Name: L] || |

Zip Code or Postal Code L] “ ]

Attach all documentation: [

‘iﬂiﬁi] ‘Lﬂ‘l] 0items in the list

Titls Name Date Size Path ]

4 [o]

| confirm that the predicate tobacco product was commercially marketed (other than exclusively for test marketing) in the United States as of February 15, 2007. | (] ‘

_ - e ﬁ _
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged: ‘

y Equi ission: Predicate Manufacturer )|

Screen View

Qverview > Submission Information > Tobacco Product Information > Predicate Manufacturer Information > Manufacturing/Packaging Sites Information > Submission
Information and Contents

You are in the Tobacco Preduct Information section. This section requests tobacco product information, including product category and product sub-category.

- -
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submission Name: SL2IRiE lo12020

Report Type: CTP: Transmittal Form

Is this Predicate Tobacco Product Manufacturer the same as the SubmitteriApplicant?

To use the eSubmitter Address Book, use the appropriate copy icons to the right.

Predicate Tobacco Product Name (Brand/Sub-Brand):

Organization Information

Organization Name

D&B D-U-N-8® Number:

FDA Establishment |dentifier (FEI):

‘Organization URL(e.g., www.fda.gov).

Organization Mailing Address:

o | 2
Address - Line 1: [ |
Address - Line 2: [ |
city [ |
State.

State, Province, or Territory Name

Zip or Postal Code:

Qutline View
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged: ‘

Screen View | Substantially i Submission: Manufacturing / Packaging Sites Relating to a issi )|

Overview > Submission Information > Tobacco Product Information > Predicate Manufacturer Information > Manufacturing/Packaging Sites Information > Submission
Information and Contents

You are in the Tobacco Preduct Information section. This section requests tobacco product information, including product category and product sub-category.
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Submission Name: SE_Form_012020

Report Type: CTP: Transmittal Form
[ ) | [~ | @ J | List Detail | Info ]| @
Add New Item
Manufacturer Type [_] Manufacture
[Z1 Contractor Manufacturer
"] Repacker/Relabeler

| Te use the eSubmitter's Address book, use the appropriate copy icons to the right

=@

Organization/Institution Information

Organization/Institution Name:

QOrganization Headquarters D&B D-U-N-5& Number.

Organization Headguariers FDA Assigned Facility Establishment Identification (FEI) Number.

Division Name

Organization URL (e.g., www.fda.gov):

Organization/institution Mailing Address:

Country:

Address - Line 1

Address - Line 2:

City:

State: -

State, Province, or Territory Name |

Zip or Postal Code [ |
Contact

Prefic.




First Name/Given Name: [ ]

Middle Name: [ |

Last Name: [ |

Generational Suffix: -
> | Generational Suffix, if Other:

Professional Suffix (e.g., MD, Ph.D.): | ‘

Position Title: [ |

Email Address: [ |

Telephone Number(s).

uﬂlﬂﬂ Q J 0 ofditems in the list

Fax Number:

TYEYEY EYEY 00f1 items in the list
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Report Type: CTP: Transmittal Form

Overview > Submission Information > Tobacco Product Information > Predicate Manufacturer Information > Manufacturing/Packaging Sites Information > Submission
Information and Contents

You are in the Submission Information and Contents section.

Submission Attachment(s)

Do you have a single file or multiple files to upload? L] ) Single File
() Multiple Files

SINGLE FILE

Please attach your file.

File Attachment G | o Q i) “

‘What is included in the single file? Select all that apply.

Administrative

Product Information

Health and Research (Select only one if this applies)

Comparisons (New vs. Predicate Tobacce Product)




[

[] Compsotion - Ingredients, Non-Tobacco
[] Other features - HPHC
[] Other (Specify below)

*> | Other ‘
Envirenmental Censiderations (Select only one if this applies) O Environmental Assessment
) Claim for Categorical Exclusion
MULTIPLE FILES
Indicate the categeries for the multiple files in this submission @ | [ Administrative

[C Product Information

[] Health and Research

|| Comparisons

7 Envi | Considerati
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Report Type:

CTP: Transmittal Form

Screen View

Documents
Administrative Documents
Administrative ] ’j Basis of SE Determination
7] Unique i of new
and predicate tobacco product(s)
Attach your files
EiJ‘M‘iJiil L2 .ﬂ, 3 | 0items in the list
Title | Name Date Path |
+ D]
e _
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Submission Name: SE_Form_012020
Report Type: CTP: Transmittal Form

Screen View

Comparisons Documents.

Comparisons (Newvs. Predicate Tobacce Product)

[1/Product Design

] Heating Sources

] Stability

[ Applicant’s basis for SE

"] Comparison to grandfathered product (Check only
if predicate product was previously found SE.)

[_| Composition - Materials
[_| Composition - Ingredients, Tobacco

[ € i Non-Tobacco

[7] Other features - HPHC
[7] Other (Specify below)

’|Omer

Attach your files:

0 items in the list

Title Name Date

| 2] % J\LJI&\L\‘&

Path

Outline View
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Submission Name: SE_Form_012020 Last Modified:
Report Type: CTP: Transmittal Form Date Packaged:
Screen View [ i ission: Envil tal C t
Environmental Considerations (Selact only one if this applies)

Please attach your environmental considerations document

() Environmental Assessment

) Claim for Categorical Exclusion

File Attachment ch = =Y i) “

@R

Outline View
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At this time, you may save and close this submission to return to it at a Iater time. To do so, simply click Save and then Close from the File Menu or top Teol Bar. To re-open this submission after closing, select Open Existing Submission from the Intro Screen or Open from the File Menu
If you would like to package this submission at this ime in preparation for transmitting to FDA, please begin the packaging process by selecting Output = Package Files for Submission or by clicking the Package icon from the top toolbar. If any required data is missing, the packaging process will not begin and a Missing Data Report will
be displayed. Please ensure that all required questions are and all

have been attached within the submission. Specific directions for packaging your submission can be found in the eSubmitter User Manual andior Quick Guide
If you would like to prepare another submission to fulfill other FDA requirements, please select "New” from the File Menu to begin compiling a new submission and be sure to select the appropriate submission type.

X
Submission Name: SE_Form_012020 Last Modified: ~ 01/11/2021 12:20:45 PM
Report Type: CTP: Transmittal Form Date Packaged:
Screen View | Packaging: Package Files for )|
@ You have reached the end of this submission. You may now package the submission and transmitit to CTP via the CTP Portal or ESG or on CD-ROM in order to fulfill your requirements. Submission via the CTP Portal or the Electronic Submission Gateway provides secure transmission and enables the FDAto provide you with an
automated acknowledgement of receipt.




